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 Avaya Solution & Interoperability Test Lab 
 

Application Notes for Pridis Wallboard 2.0 with Avaya 

Contact Center Select 7.1 using the Real-time Data API and 

Contact Center Manager Administrator API - Issue 1.0 

 
 

Abstract 
 

These Application Notes describe the configuration steps required for Pridis Wallboard 2.0  

to successfully interoperate with Avaya Contact Center Select R7.1  using the Real-time Data 

API to access real-time data for agent and queue statistics and Contact Center Manager 

Administrator API to get list of agents, list of skills and relationship between agent and skills. 

 

Readers should pay attention to Section 2, in particular the scope of testing as outlined in 
Section 2.1, as well as observations noted in Section 2.2 to ensure that their own use cases are 
adequately covered by this scope and results. 
 
Information in these Application Notes has been obtained through DevConnect compliance 
testing and additional technical discussions. Testing was conducted via the DevConnect 
Program at the Avaya Solution and Interoperability Test Lab. 
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1. Introduction 

These Application Notes describe the configuration steps required for Pridis Wallboard to 

successfully interoperate with Avaya Contact Center Select (ACCS) using the Real-time Data API 

to access real-time data for agent and queue statistics. Pridis Wallboard also connect ACCS 

Contact Center Manager Administrator (CCMA) to get list of agents, list of skills and relationship 

between agent and skills. 
 
Pridis Wallboard display real-time and daily data visualizations for skillset and agent statistics 
through the browser. Pridis Wallboard allow to create different layouts, select the key performance 
indicators, add websites, video or other media content. Then publish the wallboard for others or 
simply show the dashboard on a central screen.  

2. General Test Approach and Test Results  

The interoperability compliance test included feature and serviceability testing. The feature 

testing focused on verifying Pridis Wallboard’s ability to receive real-time Skillset statistics 

and Agent statistics from Avaya Contact Center Select (ACCS) using the Real-time Data 

(RTD) API and get list of agents, list of skills and relationship between agent and skills using 

CCMA API. Calls were made into IP Office to the ACCS agents to generate real-time 

statistics for: 

• Agents in various states, e.g. Ready, Not Ready, Logged out. 

• Agents on ACD calls. 

 

Using the  Real-Time Reporting on ACCS was compared to the real-time statistics being displayed 

on the Pridis Wallboard. 

 

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The 

jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to 

the interoperability of the tested products and their functionalities. DevConnect Compliance 

Testing is not intended to substitute full product performance or feature testing performed by 

DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or 

completeness of a DevConnect member’s solution. 

 

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The 

jointly defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to 

the interoperability of the tested products and their functionalities. DevConnect Compliance Testing 

is not intended to substitute full product performance or feature testing performed by DevConnect 

members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of 

a DevConnect member’s solution. 

 

Avaya recommends our customers implement Avaya solutions using appropriate security and 

encryption capabilities enabled by our products. The testing referenced in these DevConnect 

Application Notes included the enablement of supported encryption capabilities in the Avaya 

products.  Readers should consult the appropriate Avaya product documentation for further 

information regarding security and encryption capabilities supported by those Avaya products. 
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Support for these security and encryption capabilities in any non-Avaya solution component is the 

responsibility of each individual vendor.  Readers should consult the appropriate vendor-supplied 

product documentation for more information regarding those products.  

 

For the testing associated with these Application Notes, the interface between Avaya systems and 

the Pridis Wallboard did not include use of any specific encryption features as requested by Pridis. 

 Interoperability Compliance Testing 

The feature testing focused on verifying Pridis Wallboard correctly displaying Skillsets and 

Agent data from ACCS. A number of call center scenarios including the following were created 

to provide data to the Contact Center. The testing includes agents on both IP Office Server 

Edition and IP Office 500v2. 

Agent login/logout 

Agent state changes 

Number of answered calls for a Skillset 

Number of dropped calls for a Skillset 

Logged in Agents for a Skillset 

Number of available agents for a Skillset 

Calls waiting in the queue for a Skillset 

Number of calls for a Skillset 

Last wait time for a Skillset 

Longest waiting time for a Skillset 

Maximum wait time for a Skillset 

Serviceability 

 

The serviceability testing focused on verifying the ability of Pridis Wallboard to recover from 

adverse conditions, such as disconnecting/reconnecting the network to Pridis Wallboard. 

 Test Results 

All test cases passed successfully. 

 Support 

Support for Pridis Wallboard is available as follows: 

Pridis B.V. 

Berencamperweg 6B 

3861 MC Nijkerk 

The Netherlands 

Phone: +31 (0)33 2475700 

E-mail: info@pridis.com 

Web: www.pridis.com 
 

 

http://www.pridis.com/
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3. Reference Configuration 
Figure 1 illustrates a sample configuration that consists of Avaya IP Office, Avaya Contact Center 

Select and Pridis Wallboard.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

Figure 1: Test Configuration for Pridis Wallboard, Avaya Contact Center Select and Avaya 

IP Office 
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4. Equipment and Software Validated 
The following equipment and software were used for the sample configuration provided: 

 

Equipment/Software  Release/Version 

Avaya IP Office Server Edition (Primary) 11.1.0.0.0 build 237 

Avaya IP Office 500 V2 (Expansion) 11.1.0.0.0 build 237 

Avaya IP Office Manager 11.1.0.0.0 build 237 

Avaya 9621G & 9641G IP Deskphone (H.323) 6.8 

Avaya Workplace 3.8.4.10.2 

Avaya J129 & J159 IP Deskphone (SIP) 

 

4.0.5 

 

Avaya 1408 Digital Deskphone R48 

Avaya Contact Center Select 7.1.0.3 

Pridis Wallboard running on Microsoft Windows 2012 R2  2.0 

SP1 hosted on VMware 6.7  

 

Compliance Testing is applicable when the tested solution is deployed with a standalone IP 

Office 500 V2 and also when deployed with IP Office Server Edition in all configurations. 
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5. Configure Avaya IP Office 

It is assumed that Avaya IP Office is already configured and running properly with all the 

necessary licenses on board. The configuration steps required to connect Avaya Contact Center 

Select with Avaya IP Office are outside the scope of these Application Notes and will therefore 

not be covered in this section. 

 

There is no extra configuration required on IP Office for the connection of Pridis Wallboard to 

Avaya Contact Center Select. 
 

6. Configure Avaya Contact Center Select 
It is implied that a working Contact Center Select is already in place and that the connections to IP 

Office are already configured. 

 Verify ACCS Multicast Stream Control  

From the ACCS server open the Multicast Stream Control application as shown below. 
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Ensure that all Agent and Skillset boxes are ticked as shown below. The others are not 

used by member application. Ensure that neither RTD Compression nor RSM 

Compression is ticked. Click on Apply or OK to finish. 
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 Configure Access Class and Pridis User to Access ACCS Realtime 
Data 

From the ACCS server open the Contact Center Server Utility application as shown below. 

 

 
 

Enter administrator credential as show below: 

 

 



NAQ; Reviewed 

SPOC 10/14/2020 

Solution & Interoperability Test Lab Application Notes 

©2020 Avaya Inc. All Rights Reserved. 

 

9 of 30 

      PridisWB-ACCS 

 

From Avaya Contact Center Management – Server Utility window, double click on Access 

Classes to open Access Classes window. 

 

 
 

Select File → New from Access Classes window to create new Access Class. 
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Enter the Name for new Access Class. 
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Click on Access tab and change Level of Access for these items: Historical Statistics, Real-time 

Statistics and Real-Time Displays as shown below and click Save. 
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Back from Avaya Contact Center Management – Server Utility window, double click on Users 

to create new user for RTD Access Class created above (not shown). From Users window, select 

File → New. 

 

 

 

 

Enter the Fist name and Last name for New User. 
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Click on Desktop tab and enter User ID and Set Password for this user. Change Access Class to 

RTD class created above. Then click Save. 
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 Create a New CCMA User 

Open a web session to the Contact Center server and Log In with the proper credentials as 

shown below. 

 

 
 

Click on Access and Partition Management  
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Right click on User Administration in the left window and click New user. 
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Enter the details of the user including the User ID, First Name, Last Name and Password. On 

Launchpad Options, select Real-Time Reporting and Contact Center Management. 
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7. Configure Pridis Wallboard 

The following sections describe the steps required to configure the base configuration required to 

enable Pridis listen for real-time data given out from the Avaya Contac Center Select via Real-

time Data API. It is implied a working system is already in place. For all other provisioning 

information such as initial installation and configuration, please refer to the product 

documentation in Section 10. 

 Configure ACCS Datasource for Pridis Wallboard 

To configure the Pridis Wallboard server navigate to the AaccDatasource file, the location of 

this file may be different on different systems but in the example below this was located at 

C:\Program Files (x86)\Pridis\Wallboard\AaccDatasource\AaccConfigurations as shown 

on the screen below. 
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Open the AaccDatasource.config file and modify all the following settings: 

 

OrganizationName:   Enter a name for the Organization, in this case “ACCSDevConnect”. 

OrganizationId:   Enter ID provided by Pridis. 

RTDUserName:   Enter ACCS Username to get Real-Time data, created on Section 6.2. 

RTPPassword:    Enter ACCS password for username above. 

CCMAAddress:  Enter ACCS Contact Center Manager Administration (CCMA) URL, 

in this case http://10.30.5.136. 

CCMAUserName:   Enter ACCS CCMA Username, created on Section 6.3. 

CCMAPassword:   Enter ACCS CCMA Password for username above. 

RTDAddress    Enter ACCS RTD address. 

CCMSIpAddress  Enter ACCS Contact Center Manager Server (CCMS) IP address. 

 

Leave the rest as default value. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

http://10.30.5.136/


NAQ; Reviewed 

SPOC 10/14/2020 

Solution & Interoperability Test Lab Application Notes 

©2020 Avaya Inc. All Rights Reserved. 

 

20 of 30 

      PridisWB-ACCS 

 

 Configure Pridis Wallboard 

Access the Pridis Wallboard by using the URL “http://<server ip address/en” as shown below  

The login screen is displayed. Log in using the appropriate credentials. 
 

 
 

The home screen is shown below. 

 

 
 

 

 



NAQ; Reviewed 

SPOC 10/14/2020 

Solution & Interoperability Test Lab Application Notes 

©2020 Avaya Inc. All Rights Reserved. 

 

21 of 30 

      PridisWB-ACCS 

 

From the home screen, press Select → New wallboard to create new wallboard 
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The new wallboard was created and shown as below with a default small grid for multiple panels 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



NAQ; Reviewed 

SPOC 10/14/2020 

Solution & Interoperability Test Lab Application Notes 

©2020 Avaya Inc. All Rights Reserved. 

 

23 of 30 

      PridisWB-ACCS 

 

Select top left panel and click to create New widget 

 

 
 

List of these widgets are shown as below, select one widget for example “Add agent list widget” 
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The following screen will be displayed and new agent list widget have been created, select Widget 

settings to configure the widget  
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Change the settings as below for this widget and leave the rest as default. 

Title    Name of this widget, example “Skill SE Group” 

Row span, Colum span Number of rows and columns using for this widget, example 

“Column span 1” and “Row span 5”  

For Skillset  Select Skillset on ACCS for this widget, in this case “SE Group” - a 

voice skillset on ACCS. 

Value to show  Select value for this widget, example “Agent status”  

 

 

 
 

 

Scroll down and press OK to save the widget. 
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In the compliance testing, the following widgets were created. Pridis Wallboard provide two 

widgets interfaces for statistics (except Agents list): Number Widget and Gauge Widget. In the 

testing, all widget is using “Number Widget”. 

 

Number of answered calls. 

Number of dropped calls. 

Logged in Agents. 

Number of available agents. 

Calls waiting in the queue. 

Number of calls. 

Last wait time. 

Expected wait time. 

Longest waiting time. 

Maximum wait time. 
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8. Verification Steps 
This section provides verification steps that may be performed in the field to verify that the 

solution is configured properly. 

 Verify Avaya Contact Center Select Real-Time Reporting 

Log in to ACCS by navigating to the IP address of the ACCS server from a web browser such as 

Internet Explorer as shown below and click on Login. 
 

 

Once logged in click on Real-Time Reporting. 
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Select the appropriate display, for example Standard_Agent_Display is chosen below, click 

on Launch Display from the main window. A number of displays can be opened at the same 

time to show agents statistics for the Contact Center. 
 

 

 

 

 
 

Click on Standard_Skillset_Display and Launch Display to show Skillset statistics: 
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 Verify Pridis Wallboard Real-Time Report  

Make some calls to the SE Group voice skillset on ACCS. The following Wallboard window 

is displaying real-time information and agents for skillset SE Group. 

 

 
 

9. Conclusion 
These Application Notes describe the procedures for configuring necessary to connect Pridis 

Wallboard 2.0 to Avaya Contact Center Select 7.1 and Avaya IP Office 11.1, as shown in Figure 

1. Pridis Wallboard was able to successfully interoperate with Avaya Contact Center Select 7.1 

and Avaya IP Office 11.1.  

10. Additional References  
Documentation related to Avaya can be obtained from https://support.avaya.com.  

i. Administering Avaya IP Office™ Platform with Web Manager, Release 11.1 Issue 2 May 

2020 

ii. Administering Avaya IP Office™ Platform with Manager, Release 11.1 Issue 2 May 2020 

iii. Deploying Avaya Contact Center Select Software Appliance, Release 7.1 Issue 03.05 

December 2019 

 

Product Documentation for Pridis Wallboard can be obtained from Pridis BV or can be obtained at: 

www.pridis.com. 

 

  

https://support.avaya.com/
http://wallboard/
http://www.pridis.com/
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